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1. An Introduction

Food of an area & region depends mainly on the climatic conditions of that place which
influence the vegetation or cattle farming and the food consumed by the locals. Continental
food, on the whole could be considered as International Cuisine, particularly influencing
British, Australia, New Zealand and American food habits. These places do not have a
distinguished cuisine of their own and are also very similar in some way or the other in terms
of taste, ingredients used, spices used, flavorings, herbs and method of cooking, like baked,
grilled, stuffed and sautéed.

Regional food generally becomes popular or famous when there is appreciation for that
cuisine and then comes the demand for it for example French Cuisine, Cuisines of England,
may all be clubbed as Continental because of the similarity in their styles though they are very
different in their own way.

If ever there has been a classy cooking style, it has been French Cuisine - very old, beautiful in
presentation, may not be simple but very elegant, full of flavors. In Modern days, Continental
Cuisine has probably come to terms with a blend of all these International cuisines together
and all worth a touch of French Class. There are preparations in particulars which use the
'Spiciest of Chilies' also! Continental cuisine, in short can be categorized as cuisine involving
bakes, grills, stews and barbeques, where a lot of fresh herbs are used for flavoring and the
chilly factor is minimal though.

The cuisines of Western countries are diverse by themselves, although there are common
characteristics that distinguish Western cooking from cuisines of Asian countries and others.
Compared with traditional cooking of Asian countries, for example, meat is more prominent
and substantial in serving-size. Steak in particular is a common dish across the West. Similarly,
to some Asian cuisines, Western cuisines also put substantial emphasis on sauces as
condiments, seasonings, or accompaniments (in part due to the difficulty of seasonings
penetrating the often larger pieces of meat used in Western cooking). Many dairy products
are utilized in the cooking process, except in nouvelle cuisine.

Wines play an important role to the Continental dish as well quoted bay Sommelier of ancient
days "Wine accompanies food as graceful as the Lady is accompanied by her Man “The cuisine
itself blends well with wines which are used to cook the food.

Fern and Branded quoted, "The mere smell of cooking can evoke a whole civilization". The
aroma and culture is what we can relate while the food is on the pot. Bon Appétit!
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2. Learning Objectives

After completion of the course students should be able to:
General strengths:

e Sound knowledge of international cuisine

e Excellent knife skills

e Able to cook variety of international dishes

e Deliver products with in real time frames

e Follows kitchen safety regulations

Cookery
e Prepare & cook Vegetables
e Prepare & cook Poultry& Game
e Prepare & cook Fish & Shellfish
e Prepare & cook Red meats
e Prepare & cook cold and hot Appetizers

Hygiene & Sanitation

e Safe handling of food

e Maintaining safe temperatures during Receiving, Preparing, Cooking, Serving, Storing&
Cleaning

e Garbage separation

e Labeling & storage procedures

e Basic cleaning procedures



DIPLOMA IN FOOD PRODUCTION

Eligibility:

Duration:

Teaching hours per week:

Effective teaching:

Industrial training:

Senior Secondary (10+2) or equivalent with
English as a subject.

One Year + six months in industry

35 Hours

34 weeks

24 weeks after the annual examinations.

TEACHING AND EXAMINATION

SCHEME
No.| Subject Subject Hours per Term
code week Marks*
THEORY
1 DFP-01 | Cookery 3 100
2 DFP-02 | Larder 2 50
3 DCS-01 | Hygiene & Sanitation 2 50
4 DFP-03 | Nutrition 1 50
5 DFP-04 | Commodities 2 50
6 DCS-02 | Food Costing 2 50
TOTAL 12 350
PRACTICAL
7 DFP-11 | Cookery 16 100
8 DFP-12 | Larder 4 100
9 DCS-11 | Computer Awareness 1 -
10 DCS-12 | Library 2 -
TOTAL 23 200
GRAND TOTAL 35 550

* Term marks will comprise 30% Mid Term Exam & 70% End Term Exam Marks.

RULES AT A GLANCE
NO. TOPIC REQUIREMENT
1 Minimum attendance required to become eligible for 75% in aggregate
exam
2. | Minimum pass marks for each theory subject 40%
3. | Minimum pass marks for each practical subject 50%
4. | Maximum duration to pass/clear all subjects/ papers | 03 academic years




COOKERY THEORY (DFP-01)

TIME ALLOTTED: 03 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Knowledge based objectives for Cookery Theory:-

After the completion of Cookery Theory subject, the Students will be able to:

1
2
3
4
5.
6
7
8
9
1

0.

Draw the structure of egg.

. Explain the balancing of recipes.
. Define and classify sauces and soups.
. Breads and bread making

Different types of pastries

. Explain the Organizational Structure of Food Production Department.
. Design the layout of Kitchen.

. Classify raw materials and their uses.
. Describe the methods of mixing food.

Kitchen equipment and its upkeep and interdepartmental coordination

UNIT

CONTENT

HOURS WEIGHTAGE
ALLOTTED FOR EXAM

Origin of hotel industry

Importance of kitchen in Hotel &
Catering establishments

Aims and objectives of Cooking
Classification of raw materials,
preparation of ingredients.

Methods of mixing foods, effect of heat
on various foods, weighing and
measure, texture of food, Culinaryterms.

08 10%

Methods of cooking with special
Application to meat, fish, vegetables,
cheese, pulses and egg. Conventional
and non-conventional methods of
cooking, solar cooking, microwave
cooking, fast food operation.

07 10%




Eggs — Structure, selection of quality,
various ways of cooking eggs with
example in each method and prevention
of blue ring formation. Varieties of fish,
meat and vegetables. Accompaniments,
garnishes and rechauffe.

10

10%

Balancing of recipes, standardization of
recipes, standard yield, maintaining
recipe files. Menu planning, portion
control, brief study of how portions are
worked out. Invalid cookery. Purchase
Specifications, quality control, Indenting
and Costing

10

10%

Description and use of the following:
Basic stocks, Aspics & Jellies. Roux
blanc, Roux blonde and Roux brun,
Recipes and quantities required to
produce 10 litres of stock, white &
brown. Recipes required to produce
one litre of the following:

Béchamel sauce, tomato sauce,
Veloute sauce, espagnole sauce,
Hollandaise and mayonnaise sauce
with the necessary precautions to be
observed while preparing these, with
minimum five derivatives of each.

Soup — Definition, classification of
soups with example in each group,
recipe for one litre consommé , 10
popular consommés with their
garnishes.

10

10%

MID TERM EXAM

Vegetables — Effect of heat on different
vegetables in acid/alkaline medium
and reaction with metals. Method of
cooking different vegetables with
emphasis on cooking asparagus,
artichokes, Brussels sprouts.

12

15%

Theory of Bread making, Bread rolls,
Bread sticks, Indian Breads.

5%

Pastry — Recipes of short crust
pastry, puff pastry, flaky pastry choux
paste, Danish pastry and their
derivatives. Recipes and method of
preparation of plain ice cream.

15

20%




9 Kltchen stewarding and upkeep of 05 05%
equipment.

10 | Staff organization of Kitchen, o
coordination with the Departments. 05 05%
Total 90 100%




LARDER THEORY (DFP-02)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Knowledge based objectives for Larder Theory:- After the completion of the Larder
Theory, the Students will be able to:

1. Design the layout of Larder Department.
2. Explain the Organizational Structure.
3. Identify and draw the tools and equipment used in Larder Department.
4. Classify and define cuts and uses of Fish, Poultry, Lamb, Beef and Pork
5. Explain the procedures of maintaining Larder Equipment.
UNIT CONTENT HOURS WEIGHTAGE
ALLOTTED FOR EXAM
1 Larder organization and layout. 06 10%
Larder control- maintenance and care of
larder equipment
2 Hors d’ oeuvre and salads- classification 06 10%
3 Fish — classification, cleaning, basic cuts 06 10%
and uses and storage
4 Poultry and game- classification 12 20%
preparation and cuts with uses
MID TERM EXAM
5 Butchery — cuts of beef, lamb, mutton 12 20%
and pork-uses and weights
6 Types of force meat and uses 06 10%
7 Assembling cold buffet, sandwiches and 06 10%
canapeés, decorative work with ice,
vegetable, butter/fat and fruit
8 Cleaning and care of larder equipment 06 10%
and tools
Total 60 100%




HYGIENE AND SANITATION (DCS-01)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 122
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBIJECTIVES: After completion of the subject a student will be able to:

1

2
3.
4
5

. Follow sanitary procedure during food handling;
Understand the importance of personal hygiene
. Analyse critical control points; and

. Understand Food Microbiology, Food Contamination and Spoilage;

. Practice laws governing the food safety and standards

No

CONTENT

TIME WEIGHTAGE
ALLOTTED | FOR EXAM

FOOD MICROBIOLOGY
e Introduction
e Microorganism groups important in food
microbiology
Viruses
Bacteria
Fungi (Yeast & Molds)
Algae
Parasites
o Factors affecting the growth of microbes
¢ Beneficial role of Microorganisms

10 15%

FOOD CONTAMINATION AND SPOILAGE
¢ Classification Of Food
¢ Contamination And Cross
Contamination
e Spoilages Of Various Food With The
Storing Method

05 10%

SANITARY PROCEDURE FOLLOWED DURIN
FOOD HANDLING

¢ Receiving,

e Storage,

e Preparation,

e Cooking,

¢ Holding, and

e Service Of The Food

\"PJ

10 20%




MID TERM EXAM

SAFE FOOD HANDLER
e Personal Hygiene discussing all the
standard.
¢ Hand Washing Procedure
o First Aid definition, types of cuts,
wounds, lacerations with reasons and
precautions.

10

15%

HAZARD ANALYSIS CRITICAL CONTROL
POINT

¢ Introduction to HACCP

e History

e Principles of HACCP

10

15%

FOOD SAFETY STANDARDS AUTHORITY
OF INDIA (FSSAI)

¢ Introduction to FSSAI

¢ Role of FSSAI

e FSSAI compliance

05

15%

GARBAGE DISPOSAL
¢ Different Methods
¢ Advantages and disadvantages
¢ Municipal Laws and Swachh Abhiyan

10

10%

Total

60

100%
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NUTRITION (DFP-03)

TIME ALLOTTED: 01 HOURS PER WEEK MAXIMUM MARKS: 50
ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 12 >
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning objectives: After completion of the Nutrition subject a student will be able to:

Develop basic awareness of important nutrients;
Knowledge of nutritional requirements for human beings;
Plan nutritionally balance menu; and

Planning of menus for special needs.

il

HOURS WEIGHTAGE

UNIT CONTENT ALLOTTED | FOR EXAM

1. | BASIC ASPECTS

e Definition of Food and Nutrition

e Importance of Food
- Physiological, o
- Psychological and 03 10%
- Social

e Functions of food (in maintaining good
health)

2. CLASSIFICATION OF NUTRIENTS
e Macro Nutrients
- Carbohydrates
o Simple
= Monosaccharides
= Disaccharides
o Complex
= Polysaccharides
- Fats
o Saturated 04 10%
o Unsaturated
= Monounsaturated
= Polyunsaturated

- Proteins
o Based on structure
= Fibrous
=  Globular

= Intermediate
o Based on composition

11



= Simple
= Conjugated
- Water
e Micro Nutrients
- Vitamins
o Water soluble
o Fat soluble
- Minerals
o Macro elements
o Trace or Micro
elements

MACRO NUTRIENTS
e Carbohydrates
- Functions of Carbohydrates
- Sources
- Recommended Daily Allowances
(RDA)
- Effects of Deficiency and excess
intake of Carbohydrates
o Fats
- Functions of Fats
- Sources
- Recommended Daily Allowances
(RDA)
- Effects of Deficiency and excess
intake of Fats
e Proteins
- Functions of Proteins
- Sources
- Recommended Daily Allowances
(RDA)
- Effects of Deficiency and excess
intake of Proteins
o Water
- Functions
- Source
- Recommended Daily Allowance
(RDA)

04

15%

MICRO NUTRIENT
e Vitamins
Functions, sources, Recommended

Daily Allowances (RDA) and Effects of

Deficiency / Excess intake of;
- Vitamins of B-Complex Group
Vitamin C
Vitamin A
Vitamin D
Vitamin E
- Vitamin K
e Minerals

04

15%

12




Functions, Sources, Recommended
Daily Allowances (RDA) and Effects of
Deficiency / excess intake of;

- Calcium

- lron

- lodine

- Sodium

- Phosphorous

MID TERM EXAM

CONSERVING NUTRIENTS
e During Storing
e During Food Preparation (Pre-cooking
e.g. Washing, Peeling, Cutting,

(o)
Chopping, Slicing, Pounding, Grinding, 04 10%
Soaking, Sprouting, Fermentation,
Mixing)
e During Cooking
BALANCED DIET
¢ Definition and its importance 03 10%
o Factors Affecting Balanced Diet (Age,
Gender and Physiological state)
MENU PLANNING
¢ Nutritionally balanced meals as per
three food group system
e Factors affecting meal planning 04 15%
e Calculation of Nutritive value of dishes
and meals
e Critical evaluation of a given meal
MENU PLANNING - FOR SPECIAL NEEDS
e Obesity
e Diabetes 04 15%
e Hypertension
e Cardiac
Total 30 100%
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COMMODITIES THEORY (DFP-04)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning Objectives for Commodities:- After the completion of the Commodities subject,
the students will be able to:

b=

© o NGO

Classify Cereals and Describe their uses and storage.
Classify Pulses and Describe their uses and storage.

Define and Classify Fruits and Vegetables.

Classify dairy products and describe the composition and storage of milk,

cheese, butter and cream.

Find and Test the food adulterants.

Fruits and vegetables classification and uses
Identification and uses of spices and herbs

Define and classify tea, coffee, coco and food colours and flavours.

Preservation of food

UNIT

CONTENT

HOURS WEIGHTAGE
ALLOTTED FOR EXAM

Cereals- wheat rice maize

Breakfast cereals like cornflakes, rice
flakes, Choco flakes and pressed rice uses
and storage

06 10%

Pulses —its types and uses

04 10%

Fruits and vegetables- classification and
uses

10 15%

Dairy products- milk —its uses composition
and storage, classification and uses of
cheese, butter, cream

10 15%

MID TERM EXAM

Prevailing food standards in INDIA, food
adulterations as public health hazard, and
common adulterants, simple tests in

06 10%

14




detection of common food adulterants, ISI,
AGMARK and FSSAI

Herbs spices and condiments- classification

o
and uses of different types 04 10%
Fruits and vegetables; classification and 05 10%
uses
Tea, coffee, coco and their sources, storage
and uses. Food flavours, essences and 10 10%
food colours with brand names.
Food Preservation — long term and short
term methods. Convenience food, sugar 05 10%
preserves and confectionery gums
Total 60 100%

15




FOOD COSTING (DCS-02)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY

MAXIMUM MARKS

Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Leaning Objectives : At the end of the term / course the Students will be able to:

1. Know different pricing methods and explain the different types of Menu.
2. Explain the importance of food costing and costing techniques.
3. Develop standard recipes and adjust the quantities using adjustment factor.
4. Define and explain Material Costing.
5. Explain in controlling food cost, labour cost, overhead cost etc.
6. Define yield and its types.
7. Calculate standard food cost and explain the techniques in portion costand
dinner cost.
HOURS WEIGHTAGE
UNIT CONTENT ALLOTTED FOR EXAM
1 Pricing
o Menu pricing styles 08 15%
e Types of menu
¢ Different methods in pricing
2 Costing
¢ Importance of food costing 07 10%
e Methods of costing
e Costing techniques
3 Standard recipes
e Use of standardized recipes 07 10%
e Developing standardized recipes
e Adjustment factor
4 Material costing
e Through purchasing
* receiving 08 15%
e issuing
e production
e sales and accounting




MID TERM EXAM

Control of
o food cost
e labour cost 10 15%
e overhead cost
e miscellaneous cost

Yield
e butchers yield o
e cooking yield 10 15%
e portion control

Costs
e determining standard food cost o
e calculating portion cost 10 20%
e calculating dinner cost

Total 60 100%
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COOKERY PRACTICAL (DFP-11)

TIME ALLOTTED: 16 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS

Marks for attendance 5

Mid-term exam marks 25

Total (Incourse Assessment Marks) 30

End term exam marks 70

Total 100

Skill based learning objectives for Cookery Practical:- After the completion of the practical
course, the student will be able to:

1. Prepare and Present Indian dishes like Rice Varieties, Dal Varieties, Indian
bread, Vegetables and Non-Vegetarian.

Prepare and Present Indian Sweets and Snacks.

Prepare and Present Tandoor dishes.

Prepare and Present festival menus.

Prepare and Present Sauces, Soups and Pastas

Prepare and Present Continental dishes of Fish, Poultry and other meatwith
accompaniments.

7. Prepare and Present Chinese Soups, Noodles and Rice Varieties etc.

o0k wN

IMPORTANT:

1. Two students to work on one station in Basic Training Kitchen.

2. Practical in Quantity Food Kitchen shall be a team activity for bulk cooking.

3. Each menu to be practiced in Basic Training Kitchen by preparing four portions of
each dish at each station.

4. Same menu to be practiced in Quantity Food Kitchen through team exercise on
minimum twenty portions.

Familiarisation of tools / equipment and their use. (One week/ 16 Hours)

A set of 60 menus shall be drawn, by the institute covering all the items listed below,
ensuring that all cooking methods have been employed. It may also be ensured that
each menu is prepared once in the basic training kitchen and once in the quantity
food kitchen.

(Hours available: 31 weeks x 4 days/week x 4 hours/day= 496 Hours)

18




Rice

Indian Bread
Dal
Vegetables
Chutney

Raita

Egg dishes
Fish dishes
Meat dishes
Chicken dishes
Shorba
Tandoor dishes

Snacks
Sweets

08 varieties

10 varieties

10 varieties

15 varieties

05 varieties

05 varieties

03 varieties

05 varieties (including two local cuisine dishes)
08 varieties (including two local cuisine dishes)
08 varieties (including two local cuisine dishes)
02 varieties

Tandoori chicken, tandoori fish, seek kabab, boti
kabab.

10 varieties (including two local cuisine dishes)
08 varieties (including two local cuisine dishes)

Special dishes for festivals — 5 festival menus (emphasis on regional cuisine-)

Continental:

Stock — white stock, brown stock, fish stock.

Sauce — Béchamel sauce, Veloute sauce, tomato, espagnole, hollandaise
and mayonnaise with 5 derivatives of each. Demi-glace, Mint sauce,
horse radish, bread sauce and apple sauce.

Compound Butters -

varieties. Soups:

Purees

Cream

Veloute

Broths

Bisques
Consommés

Cold Soups
International soups

Fish:

Baked
Grilled
Shallow fried
Deep fried
Poached

3

2 varieties
3 varieties
2 varieties
2 varieties
1 varieties
5 varieties
2 varieties
2 varieties

2 varieties
2 varieties
2 varieties
4 varieties
2 varieties

19



Chicken and other Meats:

Stew 2 varieties
Casseroles 2 varieties
Roast 2 varieties
Braised 2 varieties
Grilled/Baked 2 varieties
Chicken (Sautés) 5 varieties

Vegetables:
Preparation and cooking of vegetables — 10 varieties.

Potatoes — 10 varieties.

Farinaceous dishes:

Spaghetti and macaroni dishes — 6 varieties.
Egg:

Breakfast egg preparation — 5 varieties
Sweets:

Mousse 3 varieties

Soufflés 3 varieties

Baked 3 varieties

Steamed (Pudding) 3 varieties

Chinese:

Soups 2 varieties

Noodles & Rice 4 varieties

Chicken 2 varieties

Pork 2 varieties

Meat 2 varieties

Prawns 2 varieties

Fish 1 dish

Vegetables 3 varieties

20



Marking scheme for
Examination Cookery
Practical (DFP-11)

Maximum Marks 100 Pass Marks 50

Part ‘A’ (25 Marks)

L nh =

MARKS
Uniform & Grooming : 05
Indenting : 05
Scullery, equipment cleaning & Hygiene : 05
Journal : 10
Total : 25

Part ‘B’ (75 Marks)

1.

NOTE:

. Journal is not allowed during indenting or practical. It must be handed over to the

w

Each student will prepare five dishes in a meal. Dishes shall be from the
prescribed syllabus.

Each dish shall carry 15 marks

Parameters of assessment of each dish.

Marks
a) Temperature : 03
b) Texture/ consistency : 03
c) Aroma/ flavour : 03
d) Taste : 03
e) Presentation : 03
Total : 15

examiner before commencement of examination.

Assessment will be done by both internal and external Examiner.

Each student will prepare 04 portions of each dish/item.

Extra ingredients may be made available in case of failure but of limitedtypes and
quality (groceries and dairy products only). Only one extra attempt may be
permitted.

Uniform and grooming must be checked by the examiners before
commencement of examination.

Students are not allowed to take help from books, notes, journal or any other
person.

The Examiners will ensure that examinee adheres to Good Hygiene and Food safety
practices during the examination.

21



LARDER PRACTICAL (DFP-12)

TIME ALLOTTED: 04 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Skill Based objectives for Larder Practical:- After the completion of Larder Practical
the Students will be able to:

Prepare and Present Simple and Compound Salads.

Prepare and Present Hors d’oeuvre and Sandwiches.

Prepare and Present Cold Soups.

Assemble cold buffet and decorative works like Ice & Butter Sculpture,
Vegetable and Fruit Carving etc.

5. Prepare and Present cold cuts like Galantine, Ballottine, Mousse etc.

hobh=

1. Preparation of various simple and compound hors d'oeuvres
2. Sandwiches - 5 varieties
3. Simple salads - 5 varieties
4. Cold Soups - 3 varieties
5. Compound Salads:
Fruit based - 2 varieties
Fish based - 2 varieties
Meat based - 2 varieties
Vegetable based - 2 varieties
Preparation of salad dressings — 3 varieties
6. Butchery:
i) Lamb and Mutton — Demonstration of jointing mutton carcasses. Deboning of
mutton leg and shoulder. Curry cuts and boti kababs.
i) Pork — Demonstration and preparation of pork chops, deboning of pork leg.
iii) Fish — cuts of fish and its use in cold buffets.
iv) Poultry — Dressing, trussing and deboning.
7. Decorative Work:
i) Demonstration of Ice & Butter Sculpture

i) Hand on Training on Vegetable & Fruit Carving
8. Demonstration and Preparation of Galantine, Ballottine, Mousse etc.

22




Marking scheme for Examination Larder Practical (DFP-12)

Maximum Marks 100 Pass Marks 50

Part ‘A’ 25 Marks

Part ‘B’ 75 marks

1.

NOTE:

MARKS
Uniform & Grooming : 05
Indenting : 10
Journal : 10
Total : 25
Five dishes to be prepared as under;
i) 02 Hors d’oeuvres
i) 02 Compound salad
iii) 01 Sandwich
Each dish shall carry 12 marks
Parameters of assessment of each dish.
Marks
a) Appearance : 04
b) Taste : 04
c) Standard Recipe : 04
Total : 12
: 15

Adherence to Hygiene & Food Safety (overall)

. Journal is not allowed during indenting or practical. It must be handed over to the

examiner before commencement of examination.

Assessment will be done by both internal and external Examiner.

Each student will prepare 02 (Two) portions of each dish/item.

Extra ingredients may be made available in case of failure but of limited types and
guantity. Only one extra attempt may be permitted.

Uniform and grooming must be checked by the examiners before
commencement of examination.

Students are not allowed to take help from books, notes, journal or any other
person.

The Examiners will ensure that examinee adheres to Good Hygiene and Food safety
practices during the examination.
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COMPUTER AWARENESS (DCS-11)

TIME ALLOTTED: 01 HOURS PER WEEK

MAXIMUM MARKS: Nil

Learning Objectives:- After the completion of Computer Awareness subject, the
Students will be able to:

akrwN-=

Understand computer and its hardware & software.
To produce word document with proper formatting
To work on an excel sheet with basic functions.
Brows on net and communicate through e-mail
Prepare small power point presentations.

UNIT

CONTENT

HOURS ALLOTTED

KNOWING COMPUTER

e What is computer?
» Basic Applications of Computer
e Components of Computer System
» Central Processing Unit
» Keyboard, mouse and VDU
» Other Input devices
» Other Output devices
» Computer Memory
o Concept of Hardware and Software
» Hardware
» Software
« Application Software
% Systems software
e Concept of computing, data and information
e Applications of IECT
» e-governance
» Entertainment
e Bringing computer to life
» Connecting keyboard, mouse, monitor
and printer to CPU
» Checking power supply

OPERATING COMPUTER USING GUI BASED
OPERATING SYSTEM

e Basics of Operating System
» Operating system
> Basics of popular operating system
(LINUX, WINDOWS)
e The User Interface
» Task Bar

24




» lcons
» Menu
» Running an Application
o Operatlng System Simple Setting
Changing System Date And Time
> Changing Display Properties
» To Add Or Remove A Windows
Component
» Changing Mouse Properties
» Adding and removing Printers
e File and Directory Management
» Creating and renaming of files and
directories

UNDERSTANDING WORD PROCESSING

e Word Processing Basics
» Opening Word Processing
» Menu Bar
» Using The Help
» Using The Icons Below Menu Bar
e Opening and closing Documents
» Opening Documents
» Save and Save as
» Page Setup
» Print Preview
» Printing of Documents
e Text Creation and manipulation
Document Creation
Editing Text
Text Selection
Cut, Copy and Paste
Spell check
Thesaurus
ormatting the Text
Font and Size selection
Alignment of Text
Paragraph Indenting
Bullets and Numbering
Changing case
e Table Manipulation
» Draw Table
» Changing cell width and height
» Alignment of Text in cell
> Delete / Insertion of row and column
» Border and shading

[}
\7\7\7\7\7'”\7\7\7\7\7\7

USING SPREAD SHEET

e Elements of Electronic Spread Sheet
» Opening of Spread Sheet
» Addressing of Cells
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» Printing of Spread Sheet
» Saving Workbooks
¢ Manipulation of Cells
> Entering Text, Numbers and Dates
» Creating Text, Number and Date Series
» Editing Worksheet Data
> Inserting and Deleting Rows, Column
» Changing Cell Height and Width
e Formulas and Function
» Using Formulas
» Function

INTRODUCTION TO INTERNET, WWW AND
WEB BROWSERS

e Basic of Computer Networks
» Local Area Network (LAN)
» Wide Area Network (WAN)
e Internet
» Concept of Internet
» Applications of Internet
» Connecting to the Internet
» Troubleshooting
e World Wide Web (WWW)
e Web Browsing Softwares
» Popular Web Browsing Softwares
e Search Engines
» Popular Search Engines / Search for
content
Accessing Web Browser
Using Favourites Folder
Downloading Web Pages
Printing Web Pages
¢ Understanding URL
e Surfing the web
e Using e-governance website

YV VVY

COMMUNICATIONS AND COLLABORATION

e Basics of E-mail
» What is an Electronic Malil

e Using E-mails
» Opening Email account
» Mailbox: Inbox and Outbox
» Creating and Sending a new E-mail
> Replying to an E-mail message
» Forwarding an E-mail message
» Sorting and Searching emails

e Document collaboration

e Instant Messaging and Collaboration
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» Using Instant messaging
» Instant messaging providers
» Netiquettes

MAKING SMALL PRESENTATIONS

Basics

» Using PowerPoint

» Opening A PowerPoint Presentation

» Saving A Presentation

Creation of Presentation

» Creating a Presentation Using a

Template

Creating a Blank Presentation

Entering and Editing Text

Inserting And Deleting Slides ina

Presentation

Preparation of Slides

» Inserting Word Table or An Excel
Worksheet

» Adding Clip Art Pictures

» Inserting Other Objects

» Resizing and Scaling an Object

Presentation of Slides

» Viewing A Presentation

» Choosing a Set Up for Presentation

» Printing Slides And Hand-outs

Slide Show

» Running a Slide Show

» Transition and Slide Timings

» Automating a Slide Show

YV V V

Total

30
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